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Overview
Information, services, and solutions

The Business Objects business intelligence solution is supported by thousands 
of pages of documentation, available from the products, on the Internet, on CD, 
and by extensive online help systems and multimedia. 
Packed with in-depth technical information, business examples, and advice on 
troubleshooting and best practices, this comprehensive documentation set 
provides concrete solutions to your business problems. 
Business Objects also offers a complete range of support and services to help 
maximize the return on your business intelligence investment. See in the 
following sections how Business Objects can help you plan for and successfully 
meet your specific technical support, education, and consulting requirements.
imizing Your Information Resources
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Information resources
Whatever your Business Objects profile, we can help you quickly access the 
documentation and other information you need.

Where do I start? 
Below are a few suggested starting points; there is a summary of useful web 
addresses on page 12. 

 Documentation Roadmap

 Documentation Roadmap
The Documentation Roadmap references all Business Objects guides and 
multimedia, and lets you see at a glance what information is available, from 
where, and in what format. 
View or download the Business Objects Documentation Roadmap at 
www.businessobjects.com/services/documentation.htm

 Documentation from the products
You can access electronic documentation at any time from the product you are 
using. Online help, multimedia, and guides in Adobe PDF format are available 
from the product Help menus. 

 Documentation on the web
The full electronic documentation set is available to customers with a valid 
maintenance agreement on the Online Customer Support (OCS) website at 
www.businessobjects.com/services/support.htm

 Buy printed documentation
You can order printed documentation through your local sales office, or from the 
online Business Objects Documentation Supply Store at 
www.businessobjects.com/services/documentation.htm

 Search the Documentation CD
Search across the entire documentation set on the Business Objects 
Documentation CD shipped with our products. This CD brings together the full set 
of documentation, plus tips, tricks, multimedia tutorials, and demo materials.
Order the Documentation CD online, from the Business Objects Documentation 
Supply Store, or from your local sales office.
Information resources

http://www.businessobjects.com/services/documentation
http://www.businessobjects.com/services/documentation
http://www.businessobjects.com/services/documentation
http://www.businessobjects.com/services/documentation.htm
http://www.businessobjects.com/services/support.htm
http://www.businessobjects.com/services/documentation.htm
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 Multimedia
Are you new to Business Objects? Are you upgrading from a previous release or 
expanding, for example, from our desktop to our web solution? Try one of our 
multimedia quick tours or Getting Started tutorials. All are available via the Online 
Customer Support (OCS) website or on the Documentation CD.

How can I get the most recent documentation?
You can get our most up-to-date documentation via the web. Regularly check the 
sites listed below for the latest documentation, samples, and tips.

 Tips & Tricks
Open to everyone, this is a regularly updated source of creative solutions to any 
number of business questions. You can even contribute by sending us your own 
tips.
www.businessobjects.com/forms/tipsandtricks_login.asp

 Product documentation
We regularly update and expand our documentation and multimedia offerings. 
With a valid maintenance agreement, you can get the latest documentation – in 
seven languages – on the Online Customer Support (OCS) website.

 Developer Suite Online
Developer Suite Online provides documentation, samples, and tips to those 
customers with a valid maintenance agreement and a Developer Suite license 
via the Online Customer Support (OCS) website.

Send us your feedback
Do you have a suggestion on how we can improve our documentation? Is there 
something you particularly like or have found useful? Drop us a line, and we will 
do our best to ensure that your suggestion is included in the next release of our 
documentation: documentation@businessobjects.com

NOTE

If your issue concerns a Business Objects product and not the documentation, 
please contact our Customer Support experts. For information about Customer 
Support visit: www.businessobjects.com/services/support.htm
imizing Your Information Resources

http://www.businessobjects.com
http://www.businessobjects.com/forms/tipsandtricks_login.asp
mailto:documentation@businessobjects.com
http://businessobjects.com/services/support.htm
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Services
A global network of Business Objects technology experts provides customer 
support, education, and consulting to ensure maximum business intelligence 
benefit to your business.

How we can support you?
Business Objects offers customer support plans to best suit the size and 
requirements of your deployment. We operate three global customer support 
centers:
• Americas: San Jose, California and Atlanta, Georgia
• Europe: Maidenhead, United Kingdom
• Asia: Tokyo, Japan and Sydney, Australia

 Online Customer Support
Our Customer Support website is open to all direct customers with a current 
maintenance agreement, and provides the most up-to-date Business Objects 
product and technical information. You can log, update, and track cases from this 
site using the Business Objects Knowledge Base. 

Having an issue with the product?
Have you exhausted the troubleshooting resources at your disposal and still not 
found a solution to a specific issue? 
For support in deploying Business Objects products, contact Worldwide 
Customer Support at: www.businessobjects.com/services/support.htm

Looking for the best deployment solution for your company?
Business Objects consultants can accompany you from the initial analysis stage 
to the delivery of your deployment project. Expertise is available in relational and 
multidimensional databases, in connectivities, database design tools, 
customized embedding technology, and more.
For more information, contact your local sales office, or contact us at: 
www. businessobjects.com/services/consulting.htm

Looking for training options? 
From traditional classroom learning to targeted e-learning seminars, we can offer 
a training package to suit your learning needs and preferred learning style. Find 
more information on the Business Objects Education website: 
www.businessobjects.com/services/education.htm
Services

http://www.businessobjects.com/services/education.htm
http://www.businessobjects.com/services/support.htm
http://businessobjects.com/services/consulting.htm
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Useful addresses at a glance

Address Content
Business Objects Documentation

www.businessobjects.com/services/
documentation.htm

Overview of Business Objects documentation. Links 
to Online Customer Support, Documentation Supply 
Store, Documentation Roadmap, Tips & Tricks, 
Documentation mailbox.

Business Objects Documentation 
mailbox

documentation@businessobjects.com

Feedback or questions about documentation. 

Product documentation

www.businessobjects.com/services/
support.htm

The latest Business Objects product 
documentation, to download or view online. 

Business Objects product information

www.businessobjects.com

Information about the full range of Business 
Objects products.

Developer Suite Online

www.techsupport.businessobjects.com

Available to customers with a valid maintenance 
agreement and a Developer Suite license via the 
Online Customer Support (OCS) website. Provides 
all the documentation, latest samples, kits and tips. 

Knowledge Base (KB)

www.techsupport.businessobjects.com

Technical articles, documents, case resolutions.
Also, use the Knowledge Exchange to learn what 
challenges other users – both customers and 
employees – face and what strategies they find to 
address complex issues. From the Knowledge 
Base, click the Knowledge Exchange link.

Tips & Tricks

www.businessobjects.com/forms/
tipsandtricks_login.asp

Practical business-focused examples.
imizing Your Information Resources

http://www.businessobjects.com/services/documentation.htm
mailto:documentation@businessobjects.com
http://www.businessobjects.com/services/support.htm
http://www.businessobjects.com
http://www.techsupport.businessobjects.com/
http://www.techsupport.businessobjects.com/
http://www.businessobjects.com/forms/tipsandtricks_login.asp
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Online Customer Support

www.techsupport.businessobjects.com

www.businessobjects.com/services

Starting point for answering questions, resolving 
issues.

Information about registering with Worldwide 
Customer Support.

Business Objects Education Services

www.businessobjects.com/services/
education.htm

The range of Business Objects training options and 
modules.

Business Objects Consulting Services

www.businessobjects.com/services/
consulting.htm

Information on how Business Objects can help 
maximize your business intelligence investment.

Address Content
Useful addresses at a glance

http://www.techsupport.businessobjects.com/
http://www.businessobjects.com/services/
http://www.businessobjects.com/services/education.htm
http://businessobjects.com/services/consulting.htm
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About this guide
This guide provides a series of step-by-step tutorials to introduce you to standard 
BusinessObjects concepts.

Audience
This guide is intended for novice users of BusinessObjects who are interested in 
learning how to use BusinessObjects by creating basic queries and reports on 
the demonstration universe.

Conventions used in this guide
The conventions used in this guide are described in the table below.

Convention Indicates

This font Code, SQL syntax, computer programs. For 
example: @Select(Country\Country Id). 
This font is also used for all paths, directories, 
scripts, commands and files for UNIX.

Some code  
more code

Placed at the end of a line of code, the symbol ( ) 
indicates that the next line should be entered 
continuously with no carriage return.

$DIRECTORYPATHNAME The path to a directory in the Business Objects 
installation/configuration directory structure. For 
example:
• $INSTALLDIR refers to the Business Objects 

installation directory.
• $LOCDATADIR refers to a subdirectory of the 

BusinessObjects installation directory called 
locData.
imizing Your Information Resources
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Overview
This introductory chapter for Getting Started with BusinessObjects covers the 
following:
• What is the goal of this tutorial?
• How does the tutorial work?
• The eFashion story line
• What do I need to do the tutorial?
• Quick lesson overview
• Your comments are welcome
duction
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What is the goal of this tutorial?
This tutorial aims to introduce first-time users to BusinessObjects. Its goal is to 
teach you how to build BusinessObjects reports using corporate and personal 
data and then teach you how to analyze the data in the reports to help you make 
the decisions that affect your business.

Who is the target audience?
The main focus of this tutorial is to help users who are new to BusinessObjects 
or users who are updating from a previous version of BusinessObjects. Business 
Objects assumes that you are familiar with Microsoft Windows 2000 and NT 
interface standards and conventions but that you are using this version of 
BusinessObjects for the first time.

What does the tutorial cover?
This tutorial covers aspects of query, reporting, analysis and report distribution in 
BusinessObjects.
This tutorial covers as many aspects of BusinessObjects as possible to give first-
time users a good grounding in the basics and to introduce you to the rich 
possibilities of BusinessObjects. A tutorial cannot, of course, cover everything. 
For further information on any of the tasks shown here (and more), see the 
BusinessObjects User's Guides.
What is the goal of this tutorial?
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How does the tutorial work?
The tutorial is made up of eight lessons. The objective of each lesson is to build 
a BusinessObjects report to answer a business question. Each lesson shows you 
how to carry out the tasks needed to build the report by taking you through step-
by-step exercises.
You can do the lessons in or out of sequence. However, the lessons have been 
designed to gradually increase the complexity of the tasks you have to carry out, 
building on what you have learned in the previous lessons. Each lesson will take 
you between 10 and 15 minutes to do.
The lessons in this tutorial are based on the eFashion demo materials that are 
delivered on the BusinessObjects installation CD and on the BusinessObjects 
Documentation CD.

 New task
The first time you carry out a task in this tutorial, you get a full explanation of how 
to do it with a detailed step-by-step procedure.

 Recap task
As you progress through the lessons, you may have to carry out the same task 
again. If a task has already been explained, we will not always give the detailed 
procedure again. If you need a reminder of how to do it, look at the index to find 
out where the procedure appears in the guide.
duction
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 Multimedia Quick Tour
For some of the tasks described in this tutorial, there is also an animated 
demonstration in the multimedia Quick Tour. You can open the Quick Tour 
directly from the BusinessObjects Help menu once you have started 
BusinessObjects. 

An actual screen from Quick Tour

 Finished reports
At the beginning of each lesson, we show the report that the lesson will teach you 
to build and then take you through the steps to do it.
If you want to look at a finished report, all the reports described in this tutorial, 
Efashion.rep, Revenue.rep, Tutorial.rep are in the userDocs folder in the 
My BusinessObjects Documents folder. They are copied to this location the first 
time you run BusinessObjects from the documents folder, under the demo folder 
in the BusinessObjects Enterprise 6 program folder.
How does the tutorial work?
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The eFashion story line
It is the year 2004 and you work for eFashion, a successful retail store selling 
fashion merchandise in 11 US cities. The company currently sells 211 products 
across 12 different product lines.
You are an analyst working at eFashion Head Quarters in New York and your job 
is to produce and distribute BusinessObjects reports to all eFashion stores.
You are currently putting together a series of reports on the company’s 
performance over this last year, 2003. Some of these reports will be sent to 
selected individuals within the company and others will be published and 
available to all company employees.
duction
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What do I need to do the tutorial?
To do the tutorial, you need to have BusinessObjects installed and running on 
your computer and make sure that the following files are installed in the correct 
locations. These files are installed as part of the eFashion demo kit. If they have 
not been installed, contact the person in charge of setting up BusinessObjects in 
your company.

 Installing BusinessObjects
There are two ways you can install BusinessObjects:
• Corporate installation performed by your Business Objects administrator. You 

have access to the demonstration universes via the connection setup by the 
administrator at the corporate level.

• Individual stand-alone installation performed by you. In addition to the 
BusinessObjects product, you must install the Access Pack middleware to 
allow the automatic connection to the demonstration universe efashion.unv. 

 Installing BusinessObjects from InfoView
If you installed BusinessObjects from InfoView via an Internet browser, these 
demo materials and middleware are not automatically installed. You will need to 
copy the reports, templates, image and Excel files manually to the correct folders 
and make sure your Business Objects administrator has given you access to the 
eFashion database and universe.

 eFashion demo materials
To complete this tutorial, you need the following demo files:

File name File Type Default Location in 
Program Files

efashion.unv BusinessObjects universe. Business Objects\ 
BusinessObjects Enterprise 6\ 
demo\universes

efashion.mdb Microsoft Access database. Business Objects\ 
BusinessObjects Enterprise 6\ 
demo\databases

efashion.xls Microsoft Excel spreadsheet Business Objects\ 
BusinessObjects Enterprise 6\ 
demo\documents\
What do I need to do the tutorial?
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NOTE

The first time you run BusinessObjects the demonstration documents with the file 
extensions .rep, .xls, and .bmp, are copied from the folders indicated above, to 
the folder My Document\ My BusinessObjects Documents\ userDocs. 
This makes them easily accessible in the default location when you want to open 
them from BusinessObjects.

efashion.bmp Bitmap image of the 
eFashion corporate logo

Business Objects\ 
BusinessObjects Enterprise 6\ 
demo\documents\

efashion_md.ret
efashion.ret

\BusinessObjects 
templates.

Business Objects\ 
BusinessObjects Enterprise 6\ 
demo\templates\

efashion.rep
tutorial.rep
revenue.rep

BusinessObjects 
documents containing the 
finished tutorial reports to 
show you what they should 
look like.

Business Objects\ 
BusinessObjects Enterprise 6\ 
demo\documents

File name File Type Default Location in 
Program Files
duction
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Quick lesson overview
The table below gives a brief overview of the eight lessons in this tutorial:

Lesson Business question Learn how to..... Report Title

1 How much revenue did 
eFashion outlets make 
this year?

Create a simple query to 
build a report and format and 
organize the report data.

Efashion.rep,
Revenue 
Year 2003

2 How is revenue 
affected by regional 
and seasonal 
differences?

Manipulate variables using 
drag and drop; organize a 
report in sections and rank 
data.

Efashion.rep,
Revenue by 
Region

3 Which cities are making 
the best margin?

Use the Formula Editor to 
make calculations and 
create variables; use alerters 
to highlight interesting data.

Efashion.rep,
Margin 
Analysis

4 How has sales revenue 
progressed from 
quarter to quarter?

Display and format financial 
data in a table; calculate 
quarterly variance and 
publish the report.

Efashion.rep,
Quarterly 
Variance

5 How did product lines 
perform over the last 
four quarters?

Organize and view reports 
that contain a lot of data 
using breaks to display totals 
and subtotals; learn about 
calculation contexts; learn 
how to use a template to 
quickly format reports to 
corporate standards.

Efashion.rep,
Product 
Analysis
Quick lesson overview
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6 How do the budget 
sales figures compare 
with the actual sales 
figures?

Learn how to bring data from 
a personal data file into 
BusinessObjects and 
combine it with data from a 
BusinessObjects Universe 
query; create and format a 
chart to compare data.

Efashion.rep,
Actual v 
Budget

7 What factors impact 
sales revenue 
performance?

Use BusinessObjects drill 
mode to analyze your 
business data.

Revenue.rep, 
sales 
analysis

8 How much revenue did 
this product line make 
this week?

Set up a report to prompt 
users to choose what data 
they want to get; refresh a 
report to get the up-to-date 
data.

Tutorial.rep, 
weekly 
revenue

Lesson Business question Learn how to..... Report Title
duction
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Your comments are welcome
We encourage you to send us any suggestions, ideas or comments that you may 
have regarding this guide. Your opinions are the most important input we receive 
as we revise BusinessObjects documentation.
You can contact us by email at documentation@businessobjects.com.
To find out information about BusinessObjects products and services, visit our 
website at www.businessobjects.com.
This site also provides information on contacting our technical support services.
Your comments are welcome
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How Much Revenue Have 
Efashion Outlets Made This 
Year?
le
ss
o
n
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Overview
Here is a brief summary of this lesson’s content and planning details.

 Business question
How much revenue have eFashion outlets made this year?

 Learning objective
Learn how to create a simple query to build a report and format and organize the 
data in the report.

 Time
10 minutes

 Finished report
Efashion.rep, Revenue Year 2003



Getting Started with BusinessObjects 29

ewbogs.book  Page 29  Wednesday, January 14, 2004  4:33 PM
Objective
You want to get a high-level view of the revenue that eFashion outlets have 
generated this year. To do this, you need to get the sales revenue for all the cities 
with eFashion outlets for the current year, 2003, from your corporate database. 
To choose your data from your database, you’re going to use a BusinessObjects 
universe that has been set up for the eFashion company and which puts the 
database contents into the terms you use every day to describe your business.
This lesson takes you through all the steps needed to build the following report 
to display Revenue for Year 2003:

Before you begin
Make sure that you have everything you need installed on your computer. For 
information on what you need, see What do I need to do the tutorial? on page 21.
Objective
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Start BusinessObjects 
First, you have to start BusinessObjects. To do this:
1. Click the BusinessObjects program icon in the Business Objects group in 

the Programs menu.
What happens next depends on how BusinessObjects has been set up in 
your company. If BusinessObjects opens directly, go to the next section, Get 
the data you need.
If the The User Identification dialog box appears:

2. Enter your User Name and Password, if applicable, choose your security 
domain, and click OK.
The User Identification dialog box closes and the BusinessObjects window 
opens.

NOTE

The user name, password and security domain are assigned by your Business 
Objects supervisor or system administrator.
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Get the data you need
To create a new report, BusinessObjects has the New Report Wizard. This 
wizard guides you through how to get the data you need to build your report.
When you open BusinessObjects, the New Report Wizard displays 
automatically. If it is not opened automatically:
• Click New Report on the Standard toolbar.

The New Report Wizard displays.
1. Choose Generate a Standard Report and click Begin.

New Report 
Wizard

This is the 
layout for 
your report.
Get the data you need
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2. Click Universe and click Next.

3. Click eFashion from the box under Available Universes and click Finish.

The Query Panel displays.

This is how 
you are 
going to 
choose the 
data to 
display in 
your report.

These are 
the 
universes 
that you 
can use.
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Add data to the Query Panel
The Query Panel is where you choose which data from your database you want 
to have in your report.
1. Open the Store Folder and double-click on City.

City appears the Result Objects section.

2. Open the Measures folder and double-click Sales revenue then Quantity 
sold.

Click on the 
plus sign to 
open a 
folder

Click on the 
minus sign 
to close a 
folder
Get the data you need
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Sales revenue and Quantity sold appear in the Result Objects section.

You now have the data to build a report where you are going to display sales 
revenue and quantity sold per city. Your database has data for the last three 
years but you are only interested in the latest year, 2003. To specify that you 
only want data for this year:

3. Click the pre-defined condition option.
4. Open the Time Period folder and drag This Year into the Conditions section.

You have specified which data you want from your database and are ready to 
run the query.

Click to show 
Pre-defined 
conditions

Pre-defined 
Conditions 

option
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5. Click Run.
BusinessObjects connects to the database and retrieves the data you 
specified. The data displays in a new standard report.

Click to 
show Pre-
defined 
conditions
Get the data you need
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Display Data In A Standard Report
You have built a standard report that shows sales revenue and quantity sold for 
the eleven cities where the eFashion retail chain does business. A standard 
report displays your data in a table with a report title. As you will see later, you 
can present this data in different ways.
Your report is contained inside a BusinessObjects document. A BusinessObjects 
document contains data and at least one report. The data contained in the 
document displays in the Report Manager window.

TIP
If the Report Manager is not open, click Report Manager from the View menu. 

Report 
Manager
The query 
data displays 
in the Data 
tab.

Report windowReport tab

Standard 
toolbar

Report 
toolbar
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Save your BusinessObjects document
Before you go any further, save your document containing the report:
1. From the File menu, choose Save.

The Save As dialog box opens.

2. Choose where you want to save the document and enter a name.
By default, BusinessObjects saves BusinessObjects documents in the 
userDocs folder in the My BusinessObjects Documents folder.
The document saves with the file extension .rep.
Display Data In A Standard Report
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Organize the data
Now you have the data, let’s organize it a little differently.

Swap Quantity sold and Sales revenue columns
You can swap columns of data in a table by simply dragging and dropping:
1. Click once in the Sales revenue column to highlight the Sales revenue 

column.

2. Click again in the Sales revenue column and, holding down your left mouse 
button, drag the cursor over the Quantity sold column.

3. When the cursor changes to the swap cursor and the status bar at the bottom 
of the BusinessObjects window displays the message Drop to swap contents, 
release the mouse.

The two columns have swapped positions.

Swap 
cursor

Status bar
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Add total sales revenue
Now let’s add up the columns and display the total sales revenue for all cities. To 
do this:
1. Click in Sales revenue column.
2. Click Sum on the Report toolbar.

The total Sales revenue displays in a new row at the bottom of the table. This 
is called a footer row.

Sort sales revenue
You want to organize the cities in the table according to sales revenue so that you 
can see at a glance who is making the most revenue. To sort the data:
1. Click in the Sales revenue column.
2. Click Sorts on the Report toolbar.
3. Click Descending Sort.

The column sorts so that the highest revenue displays at the top of the list and 
the lowest at the bottom.
You see that the city of New York has the highest sales revenue for this year. 

TIP
If you make a mistake or are not happy with the result of an action you’ve just carried 
out, click Undo on the Standard toolbar or type Ctr + Z to undo the action. You can 
undo up to ten consecutive actions.

Sum

Sum
dimmed

The footer row 
displays the total 
sales revenue for 
all cites

Descending 
Sort

Undo
Organize the data
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Format the report title
Now, let’s give your report a title. Whenever you add data or text to a report it has 
to be contained. BusinessObjects has three basic containers: tables, charts and 
free-standing cells. Text, such as report title, is contained in a free-standing cell. 
A free-standing cell is a cell that is not attached to any other report element.

 Give the report a title
A Standard report contains a placeholder for a title. To edit the text in the title 
placeholder:
1. Double-click inside the cell that contains the text Report Title.

Report Title is highlighted.

2. Enter Revenue for year 2003 and press the Enter.
The new text displays in the cell.
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 Format the title
Let’s now format this title a little differently. To do this:
1. Right-click on the cell and choose Format Cell from the menu.

The Format Cell dialog box opens.

2. Click the Font tab.

3. Click 18 under Size and click Bold under Font Style.
Format the report title
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4. Click the Custom Color box and click gray from the palette, then click OK.

5. Click the Borders tab.

6. Click the None in the Presets box to remove the border from the title.
7. Click OK to close the Format Cell dialog box and save your changes.
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Your report title now looks like this:

NOTE

If you need an explanation of any of the options in the dialog boxes:
• Click Help on the dialog box.
• Click F1 on your keyboard.

A Help screen opens with short explanations of how to use each option on the 
dialog box. 

Click Help to 
get help with 
how to use 
these options

Help 
screen
Format the report title
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Display data in a chart
You are going to display some of the data in the table in a chart. To do this, you 
are going to copy the table, edit it and then turn it into a chart.
To copy the table:
1. Click and hold the left mouse button, draw a box over a part of the table.

2. Release the mouse.
A hatched gray border appears around the table.

3. Move the cursor over the table. When the cursor changes to the move cursor, 
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hold down the left mouse button and drag the cursor to the right of the table.

4. Hold the Ctrl key.
The cursor changes to the copy cursor.

5. Release the mouse.
The table copies in the new location.

Move cursor

Copy cursor

This outline shows you where the 
copy of the table will appear
Display data in a chart
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You are now going to delete the Quantity sold column. 
To do this:
1. Hold the cursor over the Quantity sold column. 
2. Click once, when the cursor changes to a black arrow pointing downwards.

The Quantity sold column is highlighted.

3. Click Delete on the Standard toolbar.
The Quantity sold column disappears from the table.

4. Select the table.
5. Click Chart on the Report toolbar.

A menu of chart types displays.

6.  Click 3-D column chart.

Delete 

3-D column chart 

Chart button

Chart options
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The data in the table displays in a chart.

Resize the chart
The chart is not large enough to display all the city names so you need to resize 
it. To do this:
1. Click once on the chart just under one of the city names.

Two borders should display. If only the outer border displays, click again just 
under one of the city names.

2. Move your cursor over the handle on the right-hand corner of the inner border. 
3. When the resize cursor displays, hold down the left mouse button and drag 

the corner to the right to resize the chart.
4. When all the city names display, release the mouse.

Click this 
area Drag this handle

Inner border

Resize 
cursor
Display data in a chart
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Rename your report
When you create a new BusinessObjects document or insert a new report, the 
report is given a default name Report 1 (2, 3 etc.).
To give your report a more meaningful name:
1. Right-click the report tab and select Rename from the menu.

2. Enter a name for the report, Revenue Year 2003, and click OK.

The new name displays on the report tab.

Report tab
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The finished report
Congratulations! You’ve created your first BusinessObjects report. Your final 
report looks like this:
The finished report
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How Do Regional And Seasonal 
Differences Affect Revenue?
le
ss
o
n
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Overview
In this lesson:

 Business question
How is revenue affected by regional and seasonal differences?

 Learning objective
Manipulate variables using drag and drop; organize a report in sections and rank 
data.

 Time
15 minutes

 Finished report
Efashion.rep, Revenue by Region
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Objective
In lesson 1, you built a report to get a high-level view of the sales revenue 
generated by your eFashion outlets. You now want to look at sales revenue in 
more detail to see how this revenue is affected by seasonal and regional 
differences. To get a more detailed view, you need to bring in some more data.
This lesson takes you through all the steps needed to build the following report 
showing the top three product lines in four eFashion regions:
Objective
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Insert a new report
You’re going to build a second report in the same BusinessObjects document so 
first let’s insert a new report tab.
1. Right-click Revenue in Year 2003 report tab and click Insert Report from the 

menu.
A new, blank report appears. Let’s give the report a name right away.

2. Right-click on new report tab and select Rename Report from the menu
3. Type in Revenue by Region in the Rename Report box and click OK.
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Get more data
The Report Manager Data tab currently shows that you have data for City, Sales 
revenue and Quantity sold stored in your BusinessObjects document. To build 
the new report, you need to use the Query Panel to get some more data. To do 
this:
1. Right-click on any variable in the list in the Data tab of the Report Manager 

and click Edit Data Provider from the menu.

The Query Panel displays. You are going to keep the data you already have 
in the report and add some data to allow you to get a more detailed look at 
your business.

2. Open the Time Period folder and double-click on Quarter.
Quarter appears in the Result Objects.

3. Open the Product folder and double-click Lines.
4. Open the Measures folder and double-click Margin.

Six objects display in Results Objects.

5. Click Run.
It will take a few moments for the query to run. The status bar displays 
messages, for example, Connecting to the database....., to inform you what 

Right-click 
here.
Get more data
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BusinessObjects is currently doing.

The new data displays in the Report Manager Data tab. You can use this data 
to build your report.

Report Manager and BusinessObjects data types

Watch this area here for messages 
while the query is running

Quarter, Lines and 
Margin are added to the 
data stored in the 
document.



Getting Started with BusinessObjects 57

ewbogs.book  Page 57  Wednesday, January 14, 2004  4:33 PM
The Report Manager Data tab displays a list of the data stored in your BusinessObjects document. 
Business Objects qualifies data used in BusinessObjects in three ways. This qualification shows how 
data can be used in reports.

Dimension objects provide the basis for analysis in a report. Dimension objects 
typically retrieve character-type data (customer names, city names, etc.), or dates 
(years, quarters, invoice dates, etc.)

A detail object is always associated to one dimension object, on which it provides 
additional information. For example, Address is a detail object associated to Store.

Measure objects retrieve numeric data that is the result of calculations on data on the 
database. Measure objects are semantically dynamic: the values they return depend 
on the objects they are used with. For example, if you include City and Sales 
Revenue in a table, revenue per city is calculated. If you include Year and Sales 
Revenue, revenue per year is calculated.

Dimension

Detail

Measure
Get more data
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Display data in a table
To build the next report, you’re going to add a new table by dragging data from 
the Report Manager Data tab to the Report window. To do this:
1. In the Report Manager select City.
2. Holding down the Ctrl key select Lines, Quarter and Sales Revenue.
3. Drag the selected objects from the Report Manager window into the Report 

window.

The cursor changes to the table insert table cursor and the status bar displays 
the message Drop to create a table.

When you release the mouse, the data you selected displays in a table:

Status bar 
message tells 
you what will 
happen when 
you release the 
mouse.

Insert Table 
cursor
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Display data in a table
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Organize the data in sections
There is a lot of data in the report and you can organize it so that it will be easier 
to read. First, you show data for each city per quarter. By creating a section in the 
report for each city you will see the sales revenue for each city per quarter more 
easily.
To do this:
1. Click once in the City column.

The City column is highlighted.
2. Click again in the City column, hold down your left mouse button and drag the 

cursor out of the table and position it over the top left of the table.
As you move the cursor out of the table, the cursor changes to the create 
section cursor.

3. When the cursor changes to the create section cursor and the status bar 
displays Drop to move contents and create a section, release the mouse.
The City column disappears from the table and a section for each of the 
eleven values of City appears. Scroll down the report to look at the different 
City sections. This type of report is called a master/detail report.

You can make the report even clearer by changing the format of the table. At the 
moment each row of the table displays sales revenue per line per quarter which 
means that quarter and line names are repeated. You can remove this repetition 
by turning the table into a crosstab.

Create section cursor

section master

section detail
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To do this:
1. Click once in the Quarter column.

The Quarter column is highlighted.
2. Click the Quarter column again, hold down your left mouse button, and drag 

the cursor to the top right-hand corner of the table.

3. When the Turn To Crosstab cursor appears and the status bar displays Drop 
to turn into a crosstab, release the mouse.
The Quarter column disappears from the table and the names of the quarters 
display in the top row of the crosstab. The names of the product lines display 
in the left column of the crosstab. Sales Revenue displays in the body of the 
crosstab.

To find the sales revenue for Accessories in Austin in Q1, look in the Austin 
section, locate Q1 in the top row and Accessories in the left column. The cell 
that forms the intersection of these two values gives you the sales revenue for 
Accessories in Q1 in Austin.

TIP
When you create the crosstab, move the cursor slowly to the top right-hand corner of 
the cell that displays the title Sales Revenue. You have to get the cursor into just the 
right position for it to become the Turn To Crosstab cursor.

Turn to 
crosstab cursor
Organize the data in sections
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Rank top three product lines
You now have a report that shows you how product lines performed in the 
different cities. What you’d like to do now is see which lines generated the top 
revenue in each quarter for each city. To do this, you’re going to rank the product 
lines according to the revenue generated:
1. Click the Lines column, where Accessories appears to highlight the column.
2. Click Apply Ranking on the Report toolbar.

The Select Top/Bottom for Lines dialog box opens.

3. Click the Top check box.
By default, BusinessObjects displays the top three.

4. Verify that Sales revenue appears in the Based on list box.
5. Click OK.

The top three revenue-making lines display in each crosstab.

Ranking
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Insert a report title
Let’s now add a title to the report to make it clear what the report is about. To add 
a title to your report, you first have to insert a cell. The cell is a container for the 
text in your title.

To insert a cell:
1. Click Insert Cell on the Report toolbar.

The cursor changes to the Insert Cell cursor.
2. Click once at the top of the page to insert a new cell.
3. When you insert a new cell, a flashing cursor appears inside so that you can 

type in text.

4. Type in a title for the report, Top Three Product Lines, and press Enter.

TIP
To edit cell contents, double-click the cell. When the contents highlight, type your 
changes and then press Enter.

To re-size the title cell:
1. Hold your cursor over the right edge of the title cell.
2. When the Resize icon appears, hold down your left mouse button and drag 

the cell border. 
- To make the cell smaller, drag to the left. 
- To make the cell wider, drag to the right.

3. Release the mouse when the entire cell contents display.

Format the title
Let’s format the cell a little differently. In the previous lesson you used a dialog 
box to change cell formatting. This time you’re going to use the Formatting 
toolbar.

Insert Cell 
button

Insert Cell 
cursor 
Insert a report title
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First, open the Formatting toolbar. To do this:
• Right-click the Standard toolbar and click Formatting from the menu.

The Formatting toolbar displays.

To format the title cell:
1. Click once on the title cell to highlight the cell.
2.  Click Font Color, on the Formatting toolbar.

The Color Palette opens.
3. Choose Dark Blue from the palette and click OK.
4. While selecting the title cell, click the drop-down arrow next to Borders to 

display the Borders options.

Font Color

Borders 

Borders options
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5. Click No Borders.
6. Click Borders. 
7. Click Bottom Border.
8. Click once outside the title cell to display the result.

The title is blue and underlined.

You have spent some time getting this formatting just right. You can now copy 
this formatting to other cells in the report so that your report design is consistent.

To copy formatting:
1. Select the title cell.
2. Click Copy on the Standard toolbar.
3. Select the cell that contains the name of the city Austin.
4. Click Paste Format on the Standard toolbar.

The formatting only, and not the content, of the title cell copies to the Austin 
cell. Notice that all the cells containing city names are also re-formatted. Any 
changes you make to one section of a master/detail report are applied to all 
sections.

No Borders

Bottom Border

Copy

Paste Format
Insert a report title
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Group cities into regions
You would like to organize your report to look at regional differences in sales 
revenue. Your database has data for cities but it doesn’t have data for regions. 
No problem. Since you have the data for cities, you can group the cities into the 
regions of your choice in your report and then calculate sales revenue by region.
To do this:
1. Click the cell that displays the city Austin.
2. While pressing the Ctrl key, select Houston, then Dallas and Miami.
3. Click Group Values on the Report toolbar.

The Rename grouped values dialog box opens.

4. Enter South, and click OK.
All the data for the cities of Austin, Houston, Dallas, and Miami group together 
into one section, South. A new variable, City+, displays in the list in the Report 
Manager Data tab.

Group Values

A new variable, City+ 
displays in the Data tab.
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5. Repeat Step 1 to Step 4 to:
- group San Francisco and Los Angeles and rename West, 
- group New York, Boston and Washington and rename East, 
- group Chicago and Colorado Springs and rename Midwest.

Your report now has four sections.
Group cities into regions
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Let’s rename City+ in the list in the Report Manager Data tab.
To do rename the variable City+:
1. Right-click on City+ in the Report Manager Data tab.
2. Choose Edit Variable from the menu.

The Edit dialog box opens.

3. Type in a new name, Region, in the Name of the Variable text box and click 
OK.
Region displays in the list in the Report Manager Data tab.
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The finished report
Your finished report looks like this:
The finished report
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Navigate through your reports
You saw earlier that the Report Manager displays all the data in your report. You 
can also use the Report Manager to navigate through the reports in your 
document.
To do this:
1. Click the Map tab in the Report Manager.

The Report Manager Map pane displays a list of all the reports in your 
document. It also displays the region section names for the report that is 
currently displayed.

2. Click West under the Revenue by Region report.
The data for West displays in the report window.
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Get a different viewpoint
Your report is currently organized so that one section appears per region and you 
see the top-selling product lines in each region. You can get a different view of 
your data by viewing by quarters instead of region.
To do this:
1. Click in the Quarter row.
2. Click and hold the Quarter row again, then drag the cursor over Region cell.
3. When the cursor changes to the Swap cursor and the status bar reads Drop 

to swap contents, release the mouse. 

Region moves to the crosstab and the report now has one section for each 
quarter.

You see that Sweat-T-Shirts were the top-selling articles for all four quarters this 
year.

Swap cursor
Get a different viewpoint
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Which Cities Are Making The 
Best Margin?
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Overview
In this lesson:

 Business question
Which cities are generating the best margin?

 Learning objective
Use the Formula Editor to make calculations and create variables; use alerters to 
highlight interesting data.

 Time
15 minutes

 Finished report
Efashion.rep, Margin Analysis
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Objective
You want to highlight the cities that generate the best margin. To do this, you 
need to do some calculations on the data in your report and create your own 
report variables.
This time, instead of using a blank report and building from scratch, you’re going 
to base your new report on the one you built in the previous lesson and re-
arrange the data in it.
This lesson takes you through all the steps needed to build the following report:
Objective
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Reorganize a report
You’re going to use the report you built in the previous lesson as a base for 
building your new report, so the first step is to duplicate the base report.

Duplicate a report
To duplicate an existing report:
1. Click the Map tab in the Report Manager.
2. Right-click on the report Revenue by Region in the list in the Report Manager 

Map tab and select Duplicate Report from the menu.

The report, Revenue by Region (1) appears in the Report Manager Map list. 
3. Double-click on Revenue by Region (1) in the Report Manager Map list.
4. Type a new name for the report Margin Analysis.

You now have three reports in your document.

Remove the sections
This report will have only one main section so you are going to remove the 
sections. To do this:
1. Select the Q1 cell and click Delete on the Standard toolbar.

The message box displays this message: You want to delete the section’s 
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master cell. Do you want to delete the section Quarter too?
2. Click Yes to delete the master cell and the section from the report.

Your report now has one section.

Turn the crosstab into a table
You want to display your data in a table and not a crosstab. To turn the crosstab 
into a table:
1. Click in the Region row.
2. Click the Region row again. While holding the left mouse button, drag the 

cursor over the left column of the crosstab.
3. When a horizontal line appears above the cursor, and the status bar reads, 

Drop to turn into a table, release the mouse button.

Delete a column of data
You do not need the data for Lines in this report so you can delete the column 
that contains this data.
To do this:
1. Select the Lines column.

2. Right-click then select Delete from the menu. 

Give the report a title
1. Double-click the title cell.
2. Type a new title for the report, Margin per City.

Turn into a table 
cursor
Reorganize a report
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Add data to the table
The data you want to use for this report is already available in the document. All 
you have to do to continue building your new report is add the data to your table 
from the Report Manager Data tab.

First, you’re going to replace Region with City. 
To do this:
1. Click the Data tab in the Report Manager.
2. In the Report Manager Data tab, select City in the variables list.
3. Click City once more and, holding down your left mouse button, drag the 

cursor over the Region column.

4. When the Region column highlights with a gray hatched border and the status 
bar displays the message Drop to replace contents, release the mouse.
The data for City replaces the data in the Region column.

Next, you’re going to add Quantity sold and Margin to the table. 
To do this:
1. From the Report Manager Data tab, select Quantity sold in the list of 

variables.
2. Click Quantity sold once more. While holding your left mouse button, drag 

the cursor to the right edge of the Sales revenue column.
3. Release the mouse when the edge of the column or row highlights with a gray 
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hatched border and the status bar displays the message Drop to insert,

The data for Quantity sold appears in a new column.

4. Now, add Margin to the table in the same way you added Quantity sold.
Add data to the table
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Calculate margin per unit
You saw in Lesson 1 that some calculations on data are carried out when you run 
a query and that you can make certain calculations on data in reports using 
toolbar buttons. You can also make calculations by writing formulas.
In this report you want to display in your table the margin per unit for each city. 
You have the necessary data, Sales revenue and Quantity sold, to calculate this 
figure already in your report.

First, let’s add a new column to the table to display this new data.
To do this:
1. Click inside the Margin column.
2. Click the drop-down arrow next to Structure on the Report toolbar

The Structure options display.

3.  Click Insert Column After.
A new, empty column appears next to the Margin column.

4. Double-click in the blue cell at the top of the column.
This cell is called the header cell.

5. Type Margin per unit and press Enter.

To calculate margin per unit you need to write a formula which divides Margin 
by Quantity sold. 
To do this, you use the Formula Editor:
1. Click inside the Margin per unit column.
2. From the Data menu, click Edit Formula.

The Formula Editor opens. The Formula Editor guides you through creating 

Structure
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your formula by choosing Variables, Functions and Operators directly from 
the lists.

3. Double-click on the equal sign (=) in the Operators list.
All BusinessObjects formulas must begin with an equal sign.

4. Double-click Margin in the Variables list.
5. Double-click the division symbol (/) in the Operators list.
Calculate margin per unit
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6. Double-click Quantity sold in the Variables list.

7. Click OK.
The result of the calculation appears in the Margin per unit column.

NOTE

The formula you create is stored in the formulas folder in the Report Manager 
Data tab.
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Create a local variable
You have the data for sales revenue and margin but since your eFashion outlets 
are in cities of different size and importance you will get a better view of how the 
different cities are performing by showing margin as a percentage of overall sales 
revenue. Again, you are going to make this calculation yourself using data you 
already have in your report but this time instead of creating a formula, you are 
going to create a local variable.
A local variable is a formula with a name. It is called a local variable because it is 
only available in the document in which it was created. However, you can use a 
local variable to build tables and charts in exactly the same way as you use 
variables retrieved using a query.

To create a local variable to calculate margin as a percentage of sales revenue:
1. Right-click the Variables folder in the Report Manager Data tab and choose 
Create a local variable
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New Variable from the menu.

The Variable Editor opens.
2. Click the Definition tab.
3. Type a name, Margin as % rev.
4. Click Measure to qualify the new variable as a measure.

5. Click the Formula tab.
The Formula Editor you used earlier displays. You build the formula for a local 
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variable by choosing from the lists in the Formula Editor as you saw earlier.
6. Double-click the equal (=) symbol in the Operators list.
7. Double-click the open bracket ( symbol in the Operators list.
8. Double-click Margin in the Variables list.
9. Double-click the division (/) symbol in the Operators list.
10.Double-click Sales revenue in the Variables list.
11.Double-click the close bracket ) symbol in the Operators list.
12.Double-click the multiply by (*) symbol in the Operators list.
13.Type 100%.

Your formula looks like this:

14.Click OK.
Create a local variable
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NOTE

The variable you create appears in the list of variables in the Report Manager 
data tab.

Add the new variable to the table
1. Add Margin as % rev to the table after the Margin per unit column in the same 

way you added Margin and Quantity sold.
Notice that the data is not yet correctly formatted as a percentage.

2. Click inside the Margin as % revenue column.
3. Click Percentage Style from the Formatting toolbar.

The data correctly formats as a percentage.Percentage Style
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Highlight cities with above-average margin
You want to highlight all the cities that made above average margin in a different 
font color to the others so that these cities will stand out from the rest in the table. 
In BusinessObjects, this kind of highlighting is called an alerter. To do this you 
need to:
• create a variable to calculate average margin
• set up an alerter

First, you are going to calculate average margin.
1. Click in the Margin as % rev column.
2. Click Calculations from the Data menu, then Average.

Average margin displays in a new row at the bottom of the table:

Next, you are going to turn the formula to calculate average margin into a 
variable.
1. Right-click on any open toolbar and choose Formula Bar from the menu.

The Formula Bar opens.

2. Click the cell that displays the Average margin.
The formula BusinessObjects used to calculate the average margin appears 
in the Formula Bar.
Highlight cities with above-average margin
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3. Click Define As Variable on the Formula Bar.
The Define the variable dialog box opens.

4. Type Average margin in the Name box. 
5. Click Evaluate the formula in its context.
6. Click OK.

The variable Average margin appears in the variables list in the Report 
Manager Data tab.

Define As Variable
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You’re now ready to set up the alerter. To do this:
1. Click once in the City column.
2. Click the Alerter on the Report toolbar.

The Alerters dialog box opens.

3. Click Add.
The Edit Alerters dialog box opens.

4. Type Above Average Margin in the Name box and then type in a description 
of what the alerter does.

Alerter
Highlight cities with above-average margin
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5. Click the Conditions tab.
This is where you define how the alerter displays and when it displays.

6. Click the drop-down arrow under Variable to Compare and select Margin as 
% rev.

7. From the Operator 1 list box, choose > (greater than symbol).
The Value 1 box appears.
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8. Click the drop-down arrow next to the Value 1 box and select Variables.
The Variables dialog box opens.

9. Click Average margin from the variables list and click Insert.
10.Click None under Variable 2.
11.Click the drop-down arrow under Result where Cell Content displays and 

select Format.
The Cell Format dialog box opens.
Highlight cities with above-average margin
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12.Click the Font tab, and set the color to red, the font style to bold and click OK.
The Conditions tab now appears as illustrated below:

13.Click OK to close the Edit Alerters dialog box.
The alerter displays in the alerters list.

14.Click OK to close the Alerters dialog box.
The names of those cities that produced above average margins this year 
now appear in bold, red type.

When the check 
box is selected, 
the alerter is active.
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The finished report
In your finished report, the cities that produced above average revenue clearly 
stand out from the rest:
The finished report
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How Has Sales Revenue 
Progressed From Quarter To 
Quarter?
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Overview
In this lesson:

 Business question
How has sales revenue progressed from quarter to quarter?

 Learning objective
Display and format financial data in a table; calculate quarterly variance and 
publish the report.

 Time
15 minutes

 Finished report
Efashion.rep, Quarterly Variance
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Objective
You want to see how your business has progressed from quarter to quarter over 
the past year. You are going to do this by building a report to compare the 
difference in certain indicators from quarter to quarter. These indicators include 
those you got from your database, such as sales revenue, and those you have 
set up yourself, such as margin as a percentage of sales revenue.
This lesson takes you through all the steps needed to build the following report:
Objective
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Before you begin
You are again going to base this new report on the one created in the previous 
lesson so you need to copy and rename this report. You also need to turn the 
alerter off.

Duplicate and rename
• Duplicate the report Margin Analysis and rename it as Quarterly Variance.

Remove the alerter on city
You do not want to display the alerter you have set up in this report. When you 
turn an alerter off, it is not deleted, so you can always turn it on again if necessary. 
To turn the alerter off:
1. Click once in the City column.
2. Click Alerter on the Report toolbar.

The Alerters dialog box opens.

3. Clear the check box next to Above average margin.
4. Click OK.
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Organize the data
In this report, you are interested in the differences between quarters and not in 
the differences between cities so you are going to replace city with quarter in your 
table. You also no longer want to display the footer row at the bottom of the table 
that displays the average. 
To do this:
1. Select the footer row at the bottom of the table and click Delete on the 

Standard toolbar.
The footer row containing Average disappears from the table.

2. Click the Data tab of the Report Manager.
3. Select Quarter in the list of variables.
4. Click again on Quarter and, holding down your left mouse button, drag the 

cursor over the City column.
5. When the City column highlights with a gray hatched border and the status 

bar displays the message Drop to replace contents, release the mouse.

The Quarter column replaces the City column.

Change the table orientation
You can present the data in this table better by displaying the headings in the left 
column of the table. You can do this by rotating the table.

Delete
Organize the data
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To do this:
1. Select the table.
2. Click Rotate Table on the Report toolbar.

The table rotates and the headings display in the left column of the table

Reorganize and format the table
Let’s format the table to better present the data. First, align the cell contents in 
the header column to the left.
To do this:
1. Select the left column.

This is the header column. It displays the names of the variables whose 
values are displayed in the rows.

2. Click Align Left on the Formatting toolbar.
The contents of the header column cells are aligned against the left edge of 
the cell.

Next, make the top row stand out better by centering the Quarter names and 
putting them in bold type.
To do this:
1. Select the Q1 cell.

To select a cell, click inside it once.
2. Click Align Center on the Formatting toolbar.
3. Click Bold on the Formatting toolbar.

The quarter names now stand out better in the table. Notice that any changes 
you make to one of the Quarter cells are made to all values of that variable.

Let’s verify the background color of the body cells.

Rotate Table

Align Left

Align Center

Bold
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To do this:
1. Select the Q1 column.

To select a column or row, hold your cursor over the top of it. When the cursor 
changes to a black arrow pointing down, click once.

2. Click Background Color on the Formatting toolbar.
The Color Palette opens.

3. Click White on the Color palette and click OK.
All the Quarter columns appear in gray.

Background 
Color
Organize the data
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Calculate the quarterly variance
You want to display the quarterly variance to see how your business has 
progressed from quarter to quarter. First, let’s calculate the difference between 
the figures in Q2 and the figures in Q1.
To do this:
1. Click in the Q2 cell.
2. Press Ctrl and click in the Q1 cell.

3. Click Variance on the Report toolbar.
The difference between each indicator for the two quarters display in a new 
cell added after the figures for Q2. This column title is Q2-Q1.

To calculate the difference in figures between Q3 and Q4:
1. Click in the Q4 cell.
2. Press Ctrl and click in the Q3 cell.
3. Click Variance on the Report toolbar.

A new column of figures displays after the figures for Q4.

Add shading to variance columns
To make the cells that show the quarterly variance stand out, let’s shade them a 
different color.

Variance
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To do this:
1. Select the Q2-Q1 column.
2. Press Ctrl and select the Q4-Q3 column.
3. Both the Q2-Q1 and Q4-Q3 highlight.
4. Click Background Color on the Formatting toolbar
5. Choose Pale Orange from the color palette and click OK.

The variance columns stand out from the rest.

Background 
color
Calculate the quarterly variance
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Add the finishing touches
This report will be read by the whole company so you’re going to add the 
company logo as well as give it a title.

Give the report a title
Type in a new title, Quarterly Variance, in the title cell.

Add the company logo
To finish off your report, you want to add the eFashion corporate logo. The logo 
is an image file and to add an image you first need to insert a cell to contain the 
image and then resize it.
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To do this:
1. Insert a new cell in the top left-hand corner of the report and press Enter.

If necessary, you may need to move the title over to the right to make room.
2. Right-click the cell, then click Format Cell from the menu.

The Cell Format dialog box opens.
3. Click the Appearance tab.

4. Under the Size box, click the Width box and type 14, click the Height box and 
type 13, then click OK.
The cell is now just the right size for the eFashion logo. 
Add the finishing touches
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To insert the logo:
1. Select the cell.
2. From the Insert menu, click Picture.

The Insert Picture cursor appears.
3. Click the report, above the table.

The Open dialog box appears.

4. Navigate to the UserDocs folder in the My BusinessObjects Documents under 
the My Documents folder.

5. Select Efashion.bmp and click Open.
The eFashion logo displays in your report.

To remove the border from around the logo:
1. Select the cell containing the logo.
2. Click No Borders on the Borders toolbar.

Insert Picture
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The finished report
Your final report looks like this:
The finished report
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Publish the report
The final step is to make the quarterly figures available to the sales and marketing 
departments throughout eFashion. To do this, you are going to publish the report 
to the BusinessObjects repository and specify which groups of users you want to 
publish the report for. The BusinessObjects repository is a centralized storage 
place which you can use to exchange documents with other BusinessObjects 
users at eFashion.
To do this:
1. Right click one of the docked toolbars and select Document Exchange.
2. Click Publish to Corporate Documents on the Document Exchange toolbar.

The Send dialog box appears.
The names of the groups to which you belong, the default document domain 
and the name of the active document are shown:

Publish to
Corporate 
Documents

If you belong to one 
user group only, the 
icon for that group 
appears here. 

The name of the 
active document 
appears here.

This is the default 
domain.
To is inactive because 
you cannot select other 
groups for Corporate 
Documents.
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NOTE

What you see in this section of the tutorial depends on how BusinessObjects has 
been set up in your company. Your repository will not have the same groups, 
categories, and document domains as those illustrated in this tutorial.

3. Click OK.
BusinessObjects displays a message box to show that you successfully 
published the documents on the repository:

For more information on sending and retrieving documents, see the 
BusinessObjects User’s Guide: Reporting Techniques and Formatting.
Publish the report
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Performed?
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Overview
In this lesson:

 Business question
How have product lines performed over the last four quarters?

 Learning objective
Learn how to organize and view reports which contain a lot of data using breaks 
to display totals and subtotals; learn about calculation contexts; learn how to use 
a template to quickly format reports to corporate standards.

 Time
15 minutes

 Finished report
Efashion.rep, Product Analysis



Getting Started with BusinessObjects 113

ewbogs.book  Page 113  Wednesday, January 14, 2004  4:33 PM
Objective
You now want to look at how your product lines have been performing in some 
detail. The report you are going to build contains a lot of data and you will see 
how you can organize and present reports containing a lot of data so that those 
reading your reports can go directly to the part that interests them.
This lesson takes you through all the steps needed to build the following report.

Before you begin
Insert a new report after Quarterly Variance and rename the new report Product 
Analysis.
Objective
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Create a new report
This time, you’re going to build a new report from scratch using the data already 
available in the document and then you’re going to quickly format it by using a 
template.

Add a table
After inserting a new report, add all the data you need in this report from the 
Report Manager Data tab.
1. In the Report Manager Data tab list, select City, Lines, Quarter, Quantity 

sold, Margin and Sales revenue.
2. Drag and drop all the selected variables into the report to create a table.
3. Organize the columns in your table in the following order: City, Quarter, Lines, 

Quantity sold, Margin, and Sales revenue.

4. Double-click the report tab and type, Product Analysis in the Rename Report 
dialog box.

5. Click OK.
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Apply a template
So far you have the data you need displayed in a simple table. You’re now going 
to organize and format this data by applying one of the eFashion corporate 
templates.
To do this:
1. Right-click on the report tab Product Analysis and select Apply Template 

from the menu.
2. The Apply a Template dialog box appears. This dialog box has a list of all the 

templates you have available in your templates folder.
3. Choose EFASHMD from the Available Templates box.

A preview of the selected template displays.

4. Click OK.
Your report reformats with the template style.
Apply a template
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Your report is now organized in sections as a master/detail report with one 
section for each city. Your table and cells are formatted using corporate fonts and 
shading.

Your report also has the eFashion company logo and a formatted placeholder for 
a report title and for a comment. Let’s fill these placeholders in right away.
1. Double-click <Title> and type Product Sales by City.
2. Double-click <add comment> and type in for year 2003.

NOTE

For information on how to set up a corporate template, see the BusinessObjects 
User’s Guide: Reporting Techniques and Formatting.
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Break up the report data
You have already seen that one way of avoiding repetition in a table is by setting 
up a report with sections. Another way of organizing data is to break up data in a 
table or crosstab.
A break allows you to display all the data for each value of a dimension variable 
together, but more importantly it allows you to display subtotals for each break 
section.
To do this:
1. Click the Quarter column.
2. Click Insert Break on the Report toolbar.

The table splits up into four sections with one section for each quarter.Insert break
Break up the report data
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3. Click the Quarter column.
4. Click Center Value Across Break on the Formatting toolbar.

The quarter cells merge into one and each quarter value displays only once.
Center Value 
Across Break



Getting Started with BusinessObjects 119

ewbogs.book  Page 119  Wednesday, January 14, 2004  4:33 PM
Make calculations
As you learned earlier, breaking up data in a table allows you to display subtotals 
as well as a grand total. You’re going to add totals for three columns of data. You 
have to add the totals for each column of data separately.
To do this:
1. Click the Margin column.
2. Click Sum on the Report toolbar.
3. Click the Sales revenue column.
4. Click Sum on the Report toolbar.
5. Click the Quantity sold column.
6. Click Sum on the Report toolbar.

NOTE

Notice that for each break section in the table, a subtotal displays a new row and 
a grand total displays at the bottom of the table. This allows you to have a total 
for each quarter and a total for the year for each city in the report.

Sum
Make calculations
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Add section headings
You are now going to add some summary information at the top of each section 
so that those reading your report can get a high level view for each city and then 
look at the details if necessary. You are going to add the sales revenue totals for 
each city next to each city name. You can do this in one easy move. But first, let’s 
add a caption for the sales revenue total.

Add a caption
To add a caption, you need to insert a cell to contain the text. An easy way to add 
a cell is to copy one that already exists in the report. The advantage of doing this 
here is to correctly format the caption cell so you do not spend time formatting it 
from scratch.
To do this:
1. Select the for year 2003 cell.
2. Click the cell again and hold while you drag the cursor and position it next to 

the Austin master cell and then press Ctrl.
3. When the cursor changes to the Copy cursor and the status bar reads Drop 

to copy contents, release the mouse.
The cell and contents copy to the new position.

4. Double-click the cell and type sales revenue.

Add section totals 
Now let’s add the sales revenue total next to the sales revenue caption.
To do this:
1. Click in the Sales revenue column.
2. Click the Sales revenue column again and hold, then drag the cursor out of 

the table and position it next to the sales revenue cell and hold down Ctrl.

Copy cursor
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3. When the cursor changes to the Copy cursor and the status bar reads Drop 
to copy contents, release the mouse.
The total sales revenue for the city displays in a new cell.

The cells containing the comment and the sales revenue total have been copied 
to all the city sections in the report. BusinessObjects has calculated the section 
totals automatically.

 Calculation contexts
A powerful feature of BusinessObjects is that you can re-use the same 
calculation in different parts of the report. BusinessObjects re-calculates 
according to the context in which you place the calculation: a grand total at the 
top of the report, section totals for each section. You can also define the 
calculation context using specific syntax which tells BusinessObjects which 
dimension objects you want to exclude or include in the calculation. For more 
information on calculation contexts, see the BusinessObjects User’s Guide.

Copy cursor
Add section headings
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Format section totals
The new cell is not formatted in the same way as the other cells in the report but 
you can quickly fix this.
1. Right-click on the City master cell and choose Copy from the menu.
2. Select the sales revenue total cell.
3. Click Paste Format on the Standard toolbar.

The formatting copies to the sales revenue total cell.

4. Now add a section total for margin following the same steps you followed to 
add a section total for sales revenue.

NOTE

You may need to move the table down slightly to make room for the section 
totals.

Paste Format



Getting Started with BusinessObjects 123

ewbogs.book  Page 123  Wednesday, January 14, 2004  4:33 PM
Align section headings
To give the report a really polished look, you can align report elements. Here, you 
are going to align the right edges of the cells containing the section totals:
To do this:
1. Right-click on any open toolbar and select Alignment from the menu.

The Alignment toolbar displays.

2. Resize the cells containing the section totals to the width of the cell contents.
3. Click the cell containing the sales revenue section total.

All the cells you now select will be aligned with this one.
4. Press Ctrl and click the cell containing the margin section total.
5. Click Align Right on the Alignment toolbar.

The cells align along the right edges.

Align Right
Add section headings
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Show in outline view
There’s a lot of information in this report. A convenient way of displaying a report 
in sections like this is to use outline view. Outline view folds up the sections in the 
report to display only the high level information that you’ve included at the top of 
each section. People viewing your reports can then open up the sections they are 
interested in to get more details.
To turn on outline view:
1. From the View menu, click Outline.

At the side of the report window, a bar with arrows displays.
2. Click 1 at the bottom of the bar.

The sections fold to display only the section title, the name of the city, and the 
section totals.

Click here to fold or unfold all sections.
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The finished report
The final report looks like this:

To view a report in outline view:
1. Click the Map tab in the Report Manager.

This gives you a list of the cities in the report.
2. Click Miami in the Map list box.

The high level information for Miami displays in the Report window.
3. Click the arrow next to Miami in the Outline bar.

The Miami section unfolds and you can view the details for the product lines 
for the four quarters of the year for Miami.
The finished report
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Compare With The Actual 
Figures?
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Overview
In this lesson:

 Business question
How do the budget sales figures compare with the actual sales figures?

 Learning objective
Learn how to bring data from a personal data file into BusinessObjects and 
combine it with data from a BusinessObjects Universe query; create and format 
a chart to compare data.

 Time
15 minutes

 Finished report
Efashion.rep, Actual - Budget
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Objective
You want to compare the actual sales figures for this year with the figures you 
forecast at the beginning of the year. You already have the actual sales revenue 
figures from the corporate database in your BusinessObjects document. Your 
sales forecast figures are in a personal spreadsheet file that you have on your 
computer. You can bring this data into BusinessObjects and then link the data 
from the database and the spreadsheet so that you can build a report to make 
your comparison.
This lesson takes you through all the steps needed to build the following report:
Objective
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Get data from a personal data file
You want to bring data from a personal spreadsheet file into your 
BusinessObjects report to compare the budget figures with the actual sales 
results.
To do this:
1. Right-click on any variable in the list in the Data tab of the Report Manager 

and choose New Data Provider from the menu.
The New Data Wizard opens.

2. Choose Access new data in a different way and click Begin.

NOTE

For more information on the third choice, Use an existing query to build a new 
one, see BusinessObjects User’s Guide: Accessing Data and Data Analysis. 

3. On the next screen, Specify Data Access, click Others, then Personal data 
files from the list box and click Finish
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.

The Access Personal Data dialog box displays. This is where you set how you 
are going to bring the data into the BusinessObjects document.

Your personal data file is a Microsoft Excel spreadsheet.
1. Click the Format drop-down arrow and select Microsoft Excel Files (.xls).

2. Click Browse and locate the file Efashion.xls in the UserDocs folder in the 
My BusinessObjects Documents folder.
Get data from a personal data file
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3. Click the First row contains column names option.
4. Click View.

The Data Manager dialog box appears.

5. Click the Definition tab.
6. In the General box, type the name for the data provider, Budget.
7. Click OK.

The new data displays in the Report Manager window.

You now have data from two different data providers in your BusinessObjects 
document. To see which data comes from which data provider, click the By Data 
Provider on the Report Manager Data tab.

data from your query

data from your 
spreadsheet

By Data Provider 
option
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Change the object qualification from measure to dimension
The month variable in Budget is interpreted as a measure when you import the 
Excel data. Since you won’t be performing calculations on it, you can change the 
variable to a dimension object. The month variable from your query is already a 
dimension so the month variable in budget should be the same.
To do this:
1. Right click on any variable in the Report Manager and select View Data.

2. Click the Definition tab in the Data Manager dialog box.
3. Click to expand Budget in the Data Providers pane, then click Month so that 

Month appears in the Name text box under Data Description. 

4. Click Dimension button and click OK.
The Month variable icon changes to a Dimension object.
Get data from a personal data file
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Link data from different sources
The next step is to link the data from the two data providers so that you can 
display data from both of them in the same table or chart, for example.
To do this:
1. From the Data menu, click View Data.

The Data Manager displays.
2. Click the Definition tab.

You gave the spreadsheet data provider a meaningful name so let’s do the 
same for the universe data provider. To do this:

3. Click Query 1 on eFashion.
4. Click the Definition tab.
5. In the General section, type a name for the data provider, Actual.
To link these two data providers together:
1. Click the plus signs (+) for Actual and Budget to open up the data provider 

lists.
A list of variables from each data source, displays.
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2. Click Quarter in the Actual list and click Link to in the Qualification box.
The Define Link Between Dimensions dialog box opens.

3. Click Quarter in the list and click OK.
4. Click OK again to close the Data Manager.
You’re now ready to build your report with actual and budget data.
Link data from different sources
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Display data in a chart
You want to display your data in a chart. First, you need to insert a new, blank 
report.
1. Click Report from the Insert menu after Product Analysis.
2. Click the report tab and rename it Actual - Budget.
3. In the Report Manager Data tab, select Quarter(Actual), Sales Revenue, 

Projected Sales Revenue and Quantity sold and drag into the Report 
window to create a table.
Notice that Quarter appears twice in the list of variables in the Report 
Manager, one from Actual and one from Budget. It doesn’t actually matter 
which one you choose.

4. Right-click on the table and choose Turn To Chart from the menu.
The Chart AutoFormat dialog box displays.
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5. Choose Column from the Chart Types list and choose the first option in the 
Styles for the Selected Chart Type section.

6. Click OK.
The data displays in a column chart.

A column chart has two axes. Measure objects, such as Sales revenue, are 
displayed on the Y-axis and dimension objects, such as Quarter, are 
displayed on the X-axis.

Y-axis

X-axis
Display data in a chart
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Organize the chart data
The chart has a different color column for each of the three measures: Projected 
Sales Revenue, Quantity sold, and Sales revenue. However, revenue and 
quantity are not calculated in the same way. Sales revenue calculates in dollars 
and quantity sold in units. The Y-axis on the chart represents dollars so you can’t 
even see the quantity sold column on the chart.
You can improve this chart in two ways:
• by using different chart types for quantity sold and for revenue
• by displaying data on two Y-axes, one axis with values in dollars and the other 

with number of units.
To do this:
1. Right-click on the chart and select Format Chart from the menu.

The Chart Format dialog box displays.

2. Click the Series tab.
3. Click the plus sign to open Group 1 and drag Quantity sold to the Secondary 

Y-axis folder.
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A new group, Group 2, appears on the secondary axis.

4. Select Group 2 and click Line from the Group Type list.l

Notice that the icon next to the Group 2 is a line chart icon.
Organize the chart data
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5. Click the Group 1 icon.
Notice that this icon is a column chart icon.
You can specify how you want your columns to be arranged by setting how 
much space you want between the sets per Quarter and whether you want 
the columns in each set to overlap.

6. Enter 50 in the Overlap text box and 100 in the Gap Width text box.

7. Click OK to close the dialog box and view the result.

Your chart now has a secondary Y-axis. Quantity sold displays as a line chart so you can 
clearly see the figures for each quarter.

The Primary 
Y-axis 
displays the 
values in 
dollars for 
projected and 
actual 
revenue 
shown in the 
column chart

The Secondary 
Y-axis displays 
the values for 
Quantity sold 
shown in the 
line chart
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Format the chart
Now let’s work on the presentation of the chart by adding a legend and changing 
the colors of the columns and lines.

Add a chart legend
A chart legend is essential here to explain what the different columns and lines 
on the chart represent.
To add a chart legend:
• Click Show/Hide Legend on the Report toolbar.

The overlapping columns clearly show where the actual sales figures went over or under 
the forecast figures.

Show/Hide 
Legend
Format the chart
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The chart legend would be better positioned at the top of the chart. To move the 
legend:
1. Click the outer border of the chart legend.

A hatched, gray border appears around the chart legend.
2. Drag the chart legend and position it above the chart.
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Change the column color
You can change the colors of the column borders and the fill. To do this:
1. Double-click on the Sales Revenue column.

The Data Series Format dialog box displays.

2. Under Fill, click on the Foreground Color color box.
3. Select a color, gray for example, from the Color dialog box and click OK.
4. Repeat the above step for Background Color.
5. Click OK to close the dialog box.
If you wish, change the color of the Projected Sales Revenue column.

Change the line color
Now let’s change the color of the line chart that displays the data for Quantity 
sold.
1. Double-click on the line chart.

The Data Series Format dialog box displays. For a line chart, you can change 
the color and width of the line and the color and shape of the data point 
markers.
Format the chart
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2. Under Line, click the Color box.

3. Select a color from the Color dialog box, dark red, for example, and click OK.
4. Click OK to close the dialog box and view the result.

Format the chart axes
You can also format the chart axes. Here, you are going to format the sales 
revenue as currency and change the color of the secondary Y-axis to the same 
color as the line chart that displays the data for Quantity sold. This will make it 
clearer to those reading your chart that the figures for Quantity sold should be 
read against the right axis and the sales revenue against the left axis.
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To format the currency:
1. Click on the data labels on the primary Y-axis on the left of the chart.

The data labels are selected as shown below:

2. Click Currency Style on the Formatting toolbar.
The sales revenue figures use the default currency style. If your default 
currency style is dollars, the dollar symbol appears in front of each figure.

NOTE

BusinessObjects uses the default currency set in the Windows Control Panel 
Regional Settings.

Currency Style
Format the chart
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To format the axis:
1. Double-click on the secondary Y-axis on the right of the chart.

The Format Axis Label dialog box displays. 

2. Click the Pattern tab.
3. Under Line, select the same color you used for the line chart, dark red in our 

example.
4. Click the Font tab.
5. Set the font color to the same color, again, dark red in our example.
6. Click OK to close the dialog box and view the results.
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The finishing touches
To finish off the report, you are going to add the corporate logo and, of course, 
give it a nicely formatted title. A quick way of adding these to this report is to copy 
them from one of the other reports in the same document and paste them into 
this report.
To do this:
1. Click on the Quarterly Variance report.
2. Right-click the eFashion logo and choose Copy from the menu.
3. Click the Actual-Budget report.
4. Right-click the top left-hand corner of the report and select Paste from the 

menu.
The eFashion logo pastes into the Actual-Budget report.

5. Now copy the title from the Quarterly Variance report into the Actual-Budget 
report in the same way and change the title to “Actual - Budget”.
The finishing touches
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The finished report
Your finished report looks like this:
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What Factors Impact Sales 
Revenue Performance?
le
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Overview
In this lesson:

 Business question
What factors impact sales revenue performance?

 Learning objective
Learn how to use BusinessObjects drill mode to analyze your business data.

 Time
15 minutes

 Finished report
Revenue.rep, sales analysis

NOTE

To perform this lesson and drill down to the database level, you must have 
installed the BusinessObjects product and Access Pack for the MS Access 
ODBC middleware. 
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Objective
You saw earlier in this tutorial how BusinessObjects allows you to get a different 
viewpoint of your business by swapping the position of data in a report.
In this lesson, you’ll see how BusinessObjects drill mode allows you to break 
down data and view it on different levels of detail to discover what is the driving 
factor behind a good or bad result.
.

What is drill mode?
If you displayed all the factors that could be useful for analysis in a table or chart, 
it could be difficult to read. Drill mode allows you to include data for analysis 
behind the scenes of your report and display only the top level data. You can then 
go down one level at a time and display more detailed information.
Typically, you start off your analysis by looking at the high-level data and when 
you spot an unusually low or high value, or an unexpected value, you can analyze 
it by displaying related data on a more detailed level.
You set up this behind-the-scenes data in the Query Panel.
Objective
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When you set up a report for analysis in drill mode, you include:
• high- level objects to display in your table or chart 
• more detailed objects in your scope of analysis
BusinessObjects retrieves the more detailed objects from the database and 
stores them behind the scenes in your report so that they are there when you 
need them.
You prepare to access this behind-the-scenes data by setting the scope of 
analysis from the Query Panel. 
To access the Query Panel, click the Edit Data Provider button on the Standard 
toolbar.

Set how many levels of detail you want to be able to drill down for the objects that 
display in the report. These drillable levels are defined by the Universe designer 
and are known as hierarchies.
For more information on hierarchies and setting up data for drill mode, see the 
BusinessObjects User’s Guide: Accessing Data and Data Analysis. The aim of 
this lesson is to show you how to use drill mode in a report that has been set up 
for drill mode analysis.

Set the scope 
of analysis here

This data will be 
displayed in the 
report.
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Open a document to analyze
You’re going to use a document that has already been set up for analysis in drill 
mode. To open this document:
1. From the File menu, click Open.

The Open dialog box displays.
2. Navigate to the UserDocs folder in the My BusinessObjects Documents 

folder.
3. Click to open Revenue.rep.

- The document contains one report, Sales Analysis. 
- The report contains a chart showing Sales revenue for the top three selling 
product lines over the last three years. 
- The report is organized in sections, with one section for each of the four 
eFashion regions.

Let’s look at the chart:
• Sales revenue in the Sweat-T-Shirt line has risen to an excellent level in 2003.
• Revenue in the ShirtWaist line has remained steady over the past three years. 
• Your top revenue-making line, Accessories in 2001 sharply decreased in 

2003.
What happened in 2003? Let’s try to pinpoint the problem in this line by looking 
at the chart in drill mode.
Open a document to analyze
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Open drill mode
To open drill mode:
1. Select the chart.
2. Click Drill on the Standard toolbar.

A new report appears that contains a copy of the selected chart. The report 
tab displays the drill icon to show you are in drill mode. The original report 
remains intact.
The Drill toolbar displays. The Drill toolbar displays East because you 
selected the chart in the section East region.

TIP
If you have not selected any table, chart or crosstab before you click drill, the cursor 
becomes a magnifying glass with a question mark next to it. If this happens, click on 
the chart to open drill mode.

Depending on how you’ve set up your toolbars, the Drill toolbar may be docked under other 
open toolbars or floating. Use the standard Windows method to dock or float the toolbars.

First, let’s see if the drop in Accessories revenue occurs only in the East or 
whether it’s a region-wide drop. 

Drill

Floating Drill 
toolbar

Docked Drill 
toolbar
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To look at the data for a different region:
1. Click the drop-down arrow next to East in the Drill toolbar and click South 

from the list.

The chart updates to show the data for the South. 

NOTE

You see that there have been similar results in this region. If you look at the data 
for the other two regions, you see that this is a nationwide drop.

You do not need to investigate regional factors any further.

2. Click the drop-down arrow next to South in the Drill toolbar and click All 
Region from the list. 
The chart updates to show the data for all eFashion regions.
Open drill mode
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Drill down for more detail
There has been a steep decline in revenue from 2001 to 2003 so let’s look at the 
year 2002 in more detail.
If you hold your cursor over the year 2002, you see that the next level of detail is 
Quarter. Let’s drill down to quarter to look at how the accessories line performed 
over the four quarters of year 2002.

To do this:
• Right-click on 2002 and click Drill Down from the menu.

The data for quarter appears in the chart and the selected value, year 2002 
appears in the Drill toolbar.

The tooltip 
shows you the 
next level of 
detail
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NOTE

You see that the accessories line was doing extremely well in Q1 and Q2 and 
then there was a steep drop in Q3 followed by a further drop in Q4. 

What happened with the this line in Q3?
Let’s look more closely at the accessories product line. If you hold your cursor 
over accessories, you see that the next level down is category. Let’s look at this 
to see whether certain categories of products are responsible for the decline in 
revenue or whether this is an overall trend. 
To do this:
• Double-click Accessories to drill down to Category.

TIP
You may need to enlarge the size of the chart at this point to see all the data.

You see that Jewelry was the top-selling category in Q1 and Q2 and then went 
into steep decline over Q3 and Q4. This looks like a problem. 

Why did jewelry revenue decline so drastically? 
Let’s drill down on Jewelry and see if you can pinpoint the problem area.
Drill down for more detail
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Drill through to get more data
When you hold your cursor over Jewelry, you now see that the tool tip displays 
Right-click to Explore. This means there is no further data to drill down to in the 
document. No problem. You can drill through to the database and get the next 
level of data to continue your analysis.
To do this:
1. Right-click Jewelry and choose Drill Through from the menu.

The Drill Through dialog box displays.

The next level down from Category is SKU description. 
2. Select SKU description in the list and click OK.

BusinessObjects connects to the database and retrieves the requested data. 
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This may take a few moments.
The data for SKU description displays in the chart.
Drill through to get more data
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Limit the data displayed in the chart
There’s a lot of data in this chart and although you can see that one particular 
product has had a dramatic decrease in revenue, it’s difficult to pinpoint which 
one it is. Let’s limit the data displayed by only displaying the products that make 
up the top 20% of revenue. To do this:
1. Click one of the SKU descriptions on the chart.

You see the yellow background text, Right-click to explore.
2. Click Rank on the Report toolbar.

The Rank dialog box displays.

3. Click Top.
4. Click In percentage of total number of values.
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5. Type 20 in the Top box and click OK.

Clearly the problem lies with the E-watch line. Sales for this line were excellent 
in Q1 and Q2 and then there was a sharp decrease in revenue in Q3 followed by 
a continuing decline in Q4. To look at the exact figures for these four quarters, 
let’s turn the chart to a crosstab.
To do this:
• Right-click the chart and choose Turn to Crosstab from the menu.

The figures show an overall decline in accessories revenue but the fall from 
$1,081,320 in Q2 to $133,725 in Q3 is extremely worrying.
Limit the data displayed in the chart
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Send the document by email
Let’s send the results of this analysis to the product manager in charge of the E-
watch line and ask for an explanation of this dramatic fall in revenue.
To do this:
• From the File menu, click Send To, then Mail.

The a new email message window appears with your document attached.

NOTE

You can send BusinessObjects documents by email if you have Microsoft 
Outlook installed on your computer.
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How Much Revenue Did This 
Product Line Make This Week?
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Overview
In this lesson:

 Task objective
How much revenue did this product line make this week? 

 Learning objective
Learn how to set up a report to prompt users to choose which data they want to 
get from the database; how to refresh a report to get the up-to-date data.

 Time
15 minutes

 Report
Tutorial.rep, Weekly Revenue
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Objective
Efashion publishes sales figures internally on a weekly basis. You want to set up 
a report that allows product managers to focus on the specific data that interests 
them. You think they need to view the weekly sales figures for:
• a chosen product line 
• a chosen week 
To do this, you are going to set up a query that prompts users when they refresh 
a document, to choose the product line and week for which they want to view 
data. This lesson takes you through the steps to set up the report below:

NOTE

This is the last lesson of this tutorial. Some of the tasks you have to carry out to 
complete this lesson are recap tasks that are described in detail elsewhere in this 
tutorial. The procedures for recap tasks do not appear in detail in this lesson.
Objective
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Set up a new query
You are going to set up a new query in a new BusinessObjects document and 
then set conditions to prompt users to specify which data they want to have 
displayed in the report. This allows them to focus on the specific data that 
interests them.

Create a new report
First, set up the basic query.
1. Click New Report Wizard on the Standard toolbar.

The New Report Wizard opens up.
2. Choose Select a template and click Begin.
3. Choose EFASHION from the Available Templates list and click Next.
4. Choose Universe and click Next.
5. Choose efashion from the list of universes and click Finish.

The Query Panel appears.
6. Add Lines, Category and Sales revenue to the Result Objects section.

The Query Panel looks like this:

New Report 
Wizard
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Focus on specific data
You want to allow users to specify two types of data, which product line they want 
to display data for and which week. First, let’s set up the condition for product line. 
To do this:
1. From the Product folder, drag Lines to the Conditions section.

The Classes and Objects list turns into the Operators list.

2. Double-click Equal to in the Operators list.
Set up a new query
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The Operators list turns into the Operands list.

3. Double-click Type a new prompt in the Operands list.

4. Type Which product line? and press Enter.
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Next, set up a second condition to limit the data retrieved to the specified week:
1. Open the Time folder and drag Week to the Conditions section.

2. Double-click Equal to in the Operators list.
3. Double-click Type a new prompt in the Operands list.
4. Type Which week? and press Enter.
Set up a new query
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Get the data
You are now ready to run the query and retrieve the data. To do this:
1. Click Run on the Query Panel.

The Enter or select values dialog box opens.

2. Click the Which product line? box and click Values.
The List of Values box opens. This box displays a list of all the available 
product lines.
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3. Click Accessories from the list and click OK.
Accessories displays in the Enter or Select Values box.

4. Click the Which week? box and click Values.
The List of Values box opens, displaying a list of all the available weeks.

5. Choose 6 from the list and click OK.

6. Click OK to display the data in the report.

7. Click Save from the File menu before proceeding to the next section.
Set up a new query
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Format the report
Your data displays in a table. The report contains the corporate logo and a 
placeholder for a title and a comment. First, let’s give the report a title.
• Double-click on <Title> and type Weekly Sales.
Next, let’s format the table. You are going to insert a break on the Accessories 
column so that accessories does not repeat several times and so that 
accessories centers across the categories it describes.
To do this:
1. Click the Accessories column.
2. Click Insert Break on the Report toolbar.
3. Click the Accessories column again, then click Center Across Break on the 

Formatting toolbar.
Next, add a total.
• Click the Sales revenue column and click Sum on the Report toolbar.
Because you have inserted a break, you have two total rows, one for the 
Accessories subsection and one for the whole table. Since Accessories is the 
only subsection in this table, the totals are the same, so you can delete one of 
these rows.
To do this:
• Select the last row and click Delete.
Your table now looks like this:

Insert Break

Center Across 
Break

Sum



Getting Started with BusinessObjects 173

ewbogs.book  Page 173  Wednesday, January 14, 2004  4:33 PM
Add tracking information
This report is regularly updated with new data so you are going to add some 
tracking information so that you know exactly how old the data is. This is easy to 
do in BusinessObjects because you can insert commonly used types of tracking 
information in special fields that are automatically updated every time you update 
the data in a document. 
The report contains data for a specified week so it’s useful to have this 
information visible somewhere. This is the week you chose when you ran the 
query. You can insert a query prompt, such as week, directly from the Insert 
menu. But first, let’s add a caption.
To do this:
• Double-click on <add comment> and type Week:
Next, let’s add the special field.
1. Copy the Week: cell and paste the copy to the right of the original.
2. Select the second Week: cell.
3. From the Insert menu, click Special Field and then Query Prompt.

The List of Prompts dialog box displays. This box displays the list of prompts 
from your query.

4. Choose Which week? from the list and click OK.
The week you chose when you ran the query displays in the selected cell.
Add tracking information
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You are now going to add the date the report was last updated in the same way.
1. Copy the Week: cell and paste the copy under the original Week: cell.
2. Change the text to display Last updated:
3. Copy the Last updated: cell and paste the copy to the right of the original cell.
4. Select the right-hand cell.
5. From the Insert menu, click Special Field and then Date and Time, then 

Last Refresh.
The date the report was last updated, in fact the date you ran the query, 
inserts in the selected cell.
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Add a chart
To finish off the report, you are now going to add a chart to display a visual 
summary of the weekly sales revenue per category so that you can see at a 
glance the best-selling category of the week. To do this:
1. Drag and drop Category and Sales revenue from the Report Manager 

window to the Report window to create a table.
2. Right-click on the table and click Turn to Chart from the menu.

The Chart AutoFormat dialog box opens.

3. Choose 3-D Pie from the Chart Types list and then the pie chart style with the 
% labels and click OK.
The chart displays in the report.

4. Select the chart and click Show Chart Legend on the Report toolbar.
5. Reposition the chart legend below the chart and resize the chart if necessary.Show/Hide 

Legend
Add a chart
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The finished report
Your finished report now displays total weekly revenue for the Accessories 
product line with a breakdown of the figures per category. Hats, Gloves and 
Scarves were by far the best-selling category this week, making up 58% of total 
revenue.
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Display different data for a different product 
line

Let’s look at revenue for another product line, Sweaters for week 7. To do this, 
you are going to refresh the report:
1. Click Refresh on the Standard toolbar.

The Enter or Select dialog box displays.

2. Click Sweaters from the product line and 7 from the week list, and click OK.
BusinessObjects reconnects to the database, retrieves the requested data 
and updates the report with the new data, maintaining the report formatting 
and presentation.
The table and chart update with sales revenue figures for Sweaters for week 
seven. 
Notice that the special field, week, also updates to 7.

Refresh
Display different data for a different product line
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